
EE/GP140-The Earth From Space- Winter 2008   Handout #16 
         Lab Exercise #3 
 
Topic 1: Color Combination.  We will see how all colors can be produced by combining 
red, green, and blue in different proportions.  Images you see digitally are all 
combinations of these wavelengths.  Something which appears red is especially bright or 
reflective in the red wavelength range.  Something which appears yellow is bright or 
reflective in both the red and green wavelengths. 
 
1. Turn on the computer monitor and log in using your Leland ID account and password. 
Download the Ex. 3 zip folder from the class web site. Unzip the Ex. 3 folder to the 
desktop or another folder so that it will be easy to locate. 
 
2. Start the Scion Image program from the Start Menu. 
 
3. Under the File menu, select item “Import”. Find the file “Colors” in the Ex. 3 folder on 
the disk and single click to highlight it. Make sure the “TIFF” button is selected (filled-
in) and click ‘Open’. 
 
4. The file “Colors” that you opened is actually a stack of three images called “Red”, 
“Green” and “Blue” respectively, as shown in the title of each window. You will see a 
window containing a black background with a white, filled-in circle located towards the 
top left. Go to the Stacks menu, and click on the item “Next slice”. This allows you to 
cycle through the three images “Red”, “Green” and “Blue”.  
 
Each image shows the brightness of an object (in this case, a filled-in circle) at red, green 
and blue wavelengths. By combining these images in certain proportions, we can form 
any color combination we wish. 
 
5. Under the Stacks menu, click on the item “RGB to 24-bit Color”. A new window will 
appear, showing three overlapping circles of Red, Green and Blue on a black background. 
 
Notice how many different colors can be reproduced by combining red, green and blue 
light in different proportions. Images you see digitally are combinations of red, green and 
blue wavelengths. An object that is red would be particularly bright at this wavelength, 
and so forth. Green objects are highly reflective for green wavelengths. Other colors, 
such as yellow, are bright in both red and green wavelengths, or channels. 
 
6. Now, close the window entitled “24-bit color” by clicking on the icon in the top right 
corner of that window. 
 
7. We will now see what happens if we remove one of these channels. Under the Stacks 
menu, click on the item “Next Slice” or “Previous Slice” until the window entitled 
“Green” appears. Under the Edit menu, click on the item “Fill”. What should happen is 
the white circle should disappear and the whole window entitled “Green” should appear 
black. We have effectively removed the Green Channel. 
 



8. Under the Stacks menu, click on the item “RGB to 24-bit Color”. A new window will 
appear, now showing only two overlapping circles of Red and Blue on a black 
background. The Green channel, and those colors derived from green, is not present.  
 
9. Close the window entitled “24-bit color”. 
 
10. Close all remaining windows. Click ‘no’ when the program prompts you to “Save any 
changes”. 
 
11. Open the File “Colors” again, as before. That is, under the File menu, select “Import” 
and find the file “Colors” in the Ex. 3 folder on the disk and single click to highlight it.  
 
12. Make sure the “TIFF” button is selected and click “Open”. 
 
13. We will now see what happens if, instead of removing the Green channel completely, 
we reduce its brightness. Under the Stacks menu, use “Next Slice” to find the Green 
channel. 
 
14. Find the “Bucket” icon in the toolbar on the left. It should be the seventh icon down 
the first column of tools. Click that icon and move the cursor over the grayscale palette 
located on the left. The cursor should now look like a dropper.  
 
15. Select an intermediate level of brightness, some shade of gray. Then move the cursor 
over the white circle and click the left-mouse button. The white circle should change 
color to that shade of gray that you selected 
 
16. Now, go to the Stacks menu and click on the item “RGB to 24-bit color”. What do 
you see? 
 
Topic 2: Multispectral analysis of the Stanford campus 
 
17.  Open MultiSpecW32.exe from the Ex3 directory.  Under 'File', select 'Open Image'.  
Select 'Campus-732'.  Click 'OK' on the spec window that pops up. 
 
18.  This image was acquired using an airborne scanner on July 24,1990 with 3 bands 
(7,3, and 2) selected from the 24 band dataset.  The resolution is 6m/pixel.  Locate the 
Main Quad, the Oval, the Stadium, and Mitchell Building.  Use the buttons that look like 
large and small mountains (the right-most buttons) to zoom in and out.  Click on where 
you want to zoom in and press button with the large mountains.  
 
19.  How is this image, which looks generally like a photograph, being produced?  What 
wavelengths are being displayed?   
 
20.  Go to 'Processor', select 'Display Image', select 'Descriptions...' in the 'Channels' box.  
What kind of light do these wavelengths correspond to?  (red, near IR, etc?)  Note that 
bands and channels are different things. 



 
21.  Try a different display, for instance change to R=1, G=2, B=3.  What difference do 
you see? Note that you are not changing the information (wavelengths); you are just 
changing the way it is being displayed.  The display seen when RGB=3,2,1 is used is 
called a "False Color" image in this case.  Generally, near infrared wavelengths are 
displayed as red in these types of images.   
 
22.  Go to processor, select 'Display Image' again.  This time, under 'Display Type', select 
'Side by Side Channels'.  Click 'OK'.   
 
23.  Zoom out as necessary, and extend the window size (by dragging the lower right 
hand corner) so that you can see all three images side by side.  Each image shows the 
intensity of the corresponding wavelength. 
 
24.  Locate areas that differ markedly from one to the other.  For example, compare the 
appearance of the Oval and the Stadium between the 3 channels.   



 
 
25.  On the above diagram, draw the channel wavelengths used.  Suggest reasons for the 
differences of the appearance of certain objects from channel to channel.   
 
26.  Go back to the 'Processor', 'Display Image', '3 Channel Color', RGB=3,2,1 settings.  
This should result in a "false color" image.  
 
27.  Why are certain areas very red?   
 
28.  Look at the Main Quad; why do the rooftops appear green?  What about the green 
ring inside the stadium?   
 
29.  In what season was this image taken?  How can you tell?   
 
30.  Locate Avery Aquatic Center Pool.  The pool has a somewhat different configuration 
now but you should be able to see the lap pool and the diving pool.  Notice the different 
shades of blue.  The shorter the wavelength, the deeper the penetration into the water.  
Knowing this, which is the deep end of the pool?  What color does it appear?   
 
31.  Close 'campus-732'.  
 

 
 
Topic 3: Multispectral analysis of San Francisco 
 
San Francisco: a natural color image 
 
32.  Open 'sanfrancisco1' in MultiSpec. 
 
33.  Go to the channel descriptions in the same way as before.  Write down these 
descriptions, along with their corresponding range names. 
 

POOL

RETURN

LOST

0.5830.645 0.830 0.645 0.583

LOST

LOST

RETURN



34.  Decide how to display the channel so that a "natural color" image will result.  (what 
channel should be red?  blue? green?) 
 
35.  Locate familiar features such as the Golden Gate Park.  Zoom in to see individual 
streets and piers.  Does everything look the way you'd expect? 
 
36.  Close sanfransisco1. 
 
San Francisco: a false color image 
 
37.  Open sanfrancisco2.  Go to the channel descriptions. Write them down.   
 
38.  Decide how to display the channels so that a false color image will result.  Your 
vegetation should appear bright red.   
 
39.  Look at side by side channels as well.   
 
40.  Close sanfrancisco2.  Close MultiSpec,. 
 
Topic 4.  Creating multispectral images using Matlab. 
 
We are now going to use another program to generate multispectral images.  This new 
program, Matlab, has many more commands than Scion Image, and requires some simple 
computer programming steps.  We will be typing commands into a ‘command window’ 
in Matlab and examining the images produced by the program. 
 
To learn about Matlab and images, we will first read in a very simple image and then try 
a more complicated set of data. 
 
41. Start the Matlab application on the computer.  It should be in the Program Files area, 
and you can start it by going to the Start menu in the lower left corner and selecting All 
Programs. 
 
42. When Matlab starts, it will open several windows.  There will be a large window on 
the right hand side of the display in which you can type commands.  We will start by 
setting the default color table to black and white by entering the command: 
 
 colormap(gray); 
 
43. Open the text file 'raster' from the downloaded files area. Open with Notepad or some 
other text editor and inspect the contents.  Note that it is a sequence of 0's and 1's. 
 
44. This file is a string of data values that will form a recognizable image once it is 
displayed with the proper row width.  Read this file into a matrix and display it on the 
screen using the matlab commands imagesc and axis, as shown below.  Information on 
each command can be found using the matlab help command.  Sample solution code is 



given below. Sketch the output file and submit it with this week’s homework.  
Experiment with various lengths to see how the image is distorted if the line length is 
incorrect.  In your writeup illustrate the correct and also one incorrect line length value. 
 
Sample solution code (note that x and y are numbers for you 
to supply to define the size of the image!): 
 
f=fopen('raster.txt'); 
[pix,count]=fscanf(f,'%d',[x,y]); 
pix=pix'; 
pix 
 
imagesc(pix); 
axis equal; 
axis image; 
 
 
Now, we are ready to create some more complicated images.  We will read in these larger 
files by using the fopen and fread commands as shown below, instead of the fscanf 
command we used for the simple image above. 
 
45.  Open matlab and read in binary files R.1024, G.1024, and B.1024.  Read each file 
into a different array using the fread command as we used in homework 1: 
 

f=fopen('filename'); 
a=fread(f,[linelength inf],'uint8'); 

 
where the filename and the linelength are set appropriately for each file.  The three files 
for use here are all 1024 by 1024 pixels in size.  Read each file into a different array, say 
a, b, and c. 
 
46.  Create a 3-dimensional array to hold your multicolor image, as in the following 
command. The array for this is 3-dimensional, where the first two indices are for x and y 
dimensions, and the third is equal to 1, 2, or 3 for R, G, and B respectively. 
 

picture=zeros(1024,1024,3,’uint8’); 
 
If you do not create the array this way, the scaling on your final image will be incorrect 
as matlab will scale the image for you. 
 
47.  Combine these into the single array for display in matlab. The command for this will 
look like: 
 

picture(:,:,1)=a’; 
picture(:,:,2)=b’; 
picture(:,:,3)=c’; 

 



The apostrophes mean to use the transpose of the matrix, needed to make the image look 
correct on the screen. 
 
48.  Display your multicolor image using the image command: 
 
 image(picture); 
 
You should see a three color image of the Stanford area. 
 
49.  Generate a different combination of image to color mapping by repeating step 47 and 
changing the order of a, b, and c.  For example, you may want to use b, c, then a, or any 
other combination.  Repeat the display (step 48) and make sure that your selection of 
image channels makes sense when you look at the image you generate. 
 
Make sure you understand these steps. You will be using these commands in this week’s 
homework. 
 
 
 
 
 
 
 
 



 
Landsat Thematic Mapper Spectral Bands Reference 

 
Band Wavelength, µm Characteristics 
 
1 0.45-0.52 Blue-green.  Maximum penetration of water, which  
  is useful for bathymetric mapping in shallow water.   
  Useful for distinguishing soil from vegetation and  
  deciduous from coniferous plants. 
2 0.52-0.60 Green.  Matches green reflectance peak of  
  vegetation, which is useful for assessing plant vigor. 
3 0.63-0.69 Red. Matches a chlorophyll absorption band that is  
  important for discriminating vegetation types. 
4 0.76-0.90 Reflected IR.  Useful for determining biomass  
  content and for mapping shorelines. 
5 1.55-1.75 Reflected IR.  Indicate moisture content of soils and  
  vegetation. Penetrates thin clouds.  Provides good  
  contrast between vegetation types. 
6 10.4-12.5 Thermal IR.  Nighttime images are useful for  
  thermal mapping and for estimating soil moisture. 
7 2.08-2.35 Reflected IR.  Coincides with an absorption band  
  caused by hydroxyl ions in minerals.  Ratios of  
  bands 5 and 7 are used to map hydrothermically  
  altered rocks associated with mineral deposits. 
 
 


